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Agenda

®* Objectives

® Uniform Data System (UDS) Navigation

® Preliminary Reporting Environment (PRE) and Compare Data
* Offline Excel Feature

* Offline HTML Feature

®* C(Clear Data

®* Data Audit Report, Review, and Submit

® Resources

®* (Question and Answers
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Objectives for Health Centers

®* Be able to access and navigate the UDS Reporting pages.

®* Understand the data entry options, including how to automate data entry
through offline Excel and HTML options.

* Know how to review and submit your UDS Reports through the EHBs.
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Navigating the Uniform Data System
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Navigate to UDS Reports

IENS
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ﬂ Organizations Grants Free Clinics FQHC-LALs Resources

You are here: Home » Tasks » Browse » All Entities [ =]

< Pending Tasks - List

All Entities .
Click to open
report after

it’s been

Not Completed Recently Completed
Tasks

Pending Tasks =1 Detailed View| =1 Search| [l S9

Archived Tasks

Free Clinics - M < [1]» W Pagesize: 15 v Go
Requests Deadline (Due) Task Category Tracking # Task Entity Organization
Applications i
g Y All v IY N'd e v Al v |
FQHC-LALs -
02/15/2023
Requests » 11:58 PM Grant Submissions HSOCS_ I;nggitr;lance HSOSSEF _ @Edn v
Health Center CIS (131 Days)
Requests 02/15/2023
Look-Alike Applications : (113'15%;?:) ST ST I H8905- Reports (Grant) »)Start ¥
Click to open =
R i report for the

Performance first time @HRSA

Report Tasks Health Center Program




UDS Navigation

0] ptio ns All Functions

Performance Reports
UDS Upload/Download

Download File
Upload File

Clear Data

UDS Report Details

Open
Tables/

(N=Tolo]g&J * Contact Information

Status Overview

‘ X Table Patients by ZIP

Code o Last Updated On: 10/05/2022 3:52 PM EST
% 02/15/2023 (11:59 PM Lo. ... 133 g

(¢ Table 3A

! Table 3A Due Date Days Left
Due Date
% Table 3B -
Information 16 1 0
X Table 4 Resources &
% Not Started !In Progress  + Complete
x
Table 5 UDS Manual | UDS Training and Technical Assistance | Upload History | Action History | Last NoA | Training
% Table 6A Material | UDS Reviewer | User(s) With Permissions | Certified Health IT Product List Lookup | Excel Mapping
Document | Request Exemption | Verify Offline HTML Download | Compare Versions Offline E | Tool ©

ine Excel Too

% Tahle AR

You are NOW using the UDS Reporting Environment. Please prepare, validate, and submit complete calendar year UDS performance data at this time.

Shows if you are in
PRE, UDS (live EHBs)
or HTML
environment

X Status Overview

© Note:
All sections including tables, HIT information, other data elements and data audit report must be in "Complete" status in order to submit your report.

Tip: Prior to entering any data, save a copy of the blank excel template. The blank file can later be used for clearing the data if desired.

H80CS0000 .
Forms Overview

Status Tracker

o SERVIC
S .y,

%,

(o ALY, .
g

S

Helpful tip! The due date time is 11:59 your local time. @HRSA
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UDS Navigation (continued)

Includes List of
History of Acronyms and

Report Actions help materials

View Uploaded
Files

Resources [

UDS Manual | UDS Training and Technical Assistance | Upload History | Action History | Last NoA | Training
Material | UDS Reviewer | User(s) With Permissions | Certified Health IT Product List Lookup | Excel Mapping
Document | Request Exemptio Verify Offline HTML Download | Compare Versions

Excel Mapping

View contact information and
privileges

Compare Report
Versions
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UDS Navigation (continued 2)

Report Status
! Table7 UDS Report Status port
and Links to
! Table 8A
Sections TabIes/Reports Status Last Updated
!' Table 9D
! Table 9E (£’ Contact Information % Not Started =
! HIT Capabilities (# Table Patients by ZIP Code v Complete 10/07/2022 1:28 PM EST by [ NN
! Other Data Elements
(# Table 3A - Patients by Age and by v Complete 10/07/2022 1:28 PM EST by} NN
! Workforce Sex Assigned at Birth
X Report Comments [’ Universal Report v Complete -
Review
Report % Data Audit Report ( Table 3B - Demographic ! In Progress 10/07/2022 1:27 PM EST by_
Characteristics
N Review
Submit (£’ Universal Report ® Incomplete -
) (# Table 4 - Selected Patient ! In Progress 10/07/2022 1:27 PM EST by [ NG
Submit Characteristics
Report
(¢’ Universal Report X Incomplete -

G
£
Hhig

&
d

AHRSA

Health Center Program

N HEALY,
O Ty,

&




UDS NaVigation - Widgets Offline Excel Tool @

Download a Custom
Template

The Download Custom
Template option allows
Download Excel or HTML you to choose the UDS

file with only specific tables tables individually, in
groups or all tables.

Download a Blank
Template

The Download Blank
Template option
downloads ALL UDS
Tables with no data
included.

Download Excel file with no data

Download a
Template with Data
The Download Template
with Data option includes
ALL UDS tables with
information already
entered into the tables.

Download Excel file with data
currently in UDS

Upload a File
Upload complete file back to UDS Once you have
completed your data
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UDS Navigation — Widgets cont. Ve,

Compare Versions @
Submit and Print

Reference Select Year and Ve v

Year/Version: @ Make sure you have completed and validated

Click when you are ready all the required information before submitting this
to Submit the Report report.

Compare to Select Year and Ve v
Year/Version:

' Submit Performance Report

@ Compare Versions

Report Details

& Print Report

Compare data on two UDS sHcmis 1D: [N
Report versions

Print UDS Report

Last Submitted By: N/A Navigate to the
Compare feature

Report BHCMIS ID and Recently

‘/C Submitted information @HRSA
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Demo #1

UDS Navigation Demo
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Preliminary Reporting Environment (PRE) and
Comparing Report Versions
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Preliminary Reporting Environment

Preliminary Reporting Environment (PRE)

' System available as of November 4t to prepare |
report for submission

You are not able to submit the report at this
time, only prepare the report

Additional time to enter data and edit

Improved data quality with extra time

Opportunity to familiarize yourself with UDS
forms updates ahead of reporting time frame

Health Center Program
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Compare Versions

Easily view
differences
between years
or versions
within a year

From the
Resources
section, select
Compare
Versions

Select year and
versions you want
to compare, and
specific tables
within those
selections

AHRSA
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Compare Versions — Select Version

Compare Versions - Select Version

» HBOCS00

O Note:
* indicates data enfry in progress and is subject to change.
Select Versions to be Compared
2021 Version 4 v | Compare To Year/Version 2022 Version 1* v

Reference Year/Version

Find the year and
version you want to set

Click Next to
select tables to

compare
AHRSA

Health Center Program

as the reference and to

Close
compare
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Compare Versions — Select Table

I Compare Versions - Select Table
© Note:
Tables and Funding Streams shown below belong to the Reference Year/Version.
Selected Versions to Compare
Compare To Year/Version: 2022 Version 17
Select Al [ Unselect All Change Status
Select tables to
v Changed .
& ¢ Click Compare
Changed after selecting
tables

Reference Year/Version: 2021 Version 4
Tables/Sections
compare
Changed

Table Patients by ZIP Code

Table 3A - Patients by Age and by Sex Assigned at Birth
Health Center Program

Table 3B - Demographic Characteristics

Go Back to Previous Page

I
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Compare Versions - Results

Ib Compare Versions - Result Page el Prit
» HB0CS0 1: print a version
of the

O Note: comparison

Data highlighted in tables are displaying change(s) between compared versions. Values displayed in tables are Reference version and values indicated in Parenthesis are from Compare To version. In case of data

entry points that are only applicable in Reference version the Compare To values will be indicated as N/A in parenthesis.
® indicates that there is a data discrepancy between the two selected versions

BHCMIS 1D: 05E00015 - Date Requested: 10/05/2022 4:25 PM EST

Program Name: Health Center 330
Fields marked

Submission Status: Data Entry In Progress, Version 1

UDS Report - 2022 with blue circle
Reference — 2021 Version 3; Compare To - 2022 Version 1* (Values indicated in Parenthesis) .
_ ) ] are different
Table 3A - Patients by Age and by Sex Assigned at Birth .
between versions

Universal

Line Age Groups Male Patients (a) Female Patients (b)

1 Under age 1 138 (—)*® 13 (—)*®

2 Age 1 77 (—)* 64 (—)*®

3 Age 2 72(—)® 69 (—)®
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Demo #2

UDS Compare Versions Demo
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Quiz Question #1

What does the Preliminary Reporting Environment

(PRE) allow users to do? ?

A. Enter test data that is not saved in the report - - 1!_
B. View the report and tables, but not enter any data

C. Enter datain the report prior to January 15t

D. Submit the report prior to January 15t
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Quiz Question #1 Answer

What does the Preliminary Reporting Environment
(PRE) allow users to do?

Answer: (C) Enter data in the report prior to January 15t
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Offline Excel
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Offline Excel Process Overview

1. Download offline Excel files to enter data or transport data from other Excel Files

2. Enter data in Excel file. Note: File contains all UDS fields (row/column labels)

3. On completion of data entry, upload the file into UDS to populate data on the forms

4. After uploading, you can view the Edit Summary File
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Offline Excel Download Overview

e You can download an Excel file with data currently in UDS
or with no data

e Select to download individual tables or the entire report

Excel File e The downloaded file will have a system generated
Download filename and dynamic funding stream tabs for selected
tables

e You can change the file name to easily identify the file
when you save the downloaded file to your local system

N and enter data offline
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Offline Excel Download

Offline Excel Tool ®

oF AEALY,
O Ty,

All Functions

Performance Reports ~

UDS Upload/Download

‘ Download File

Upload File

Clear Data

Select one of the
download options
to download an

offline Excel or
offline HTML file

—

(i)

Download a Custom
Template

The Download Custom
Template option allows
you to choose the UDS
tables individually, in
groups or all tables.

Download a Blank
Template

The Download Blank
Template option
downloads ALL UDS
Tables with no data
included.

Download a
Template with Data
The Download Template
with Data option includes
ALL UDS tables with
information already
entered into the tables.

Upload a File

Once you have
completed your data
entry in excel, click here
to upload your file.

AHRSA
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ffl i n e Exce I Download File

» H80CS0000

ownload File |~~~

Instructions

To enter UDS data offline, select either the Excel file (spreadsheet format) or the Offline HTML file (forms-based format). Then select whether you want a blank form or to include any existing
data. Once you have made all of your selections, click the Dowload button to complete your request.

With either file you can download specific tables or all the tables required for the UDS report. Please note that each time you download a file, it will be populated with any data that is in the
EHBs

Enter or change data in the file you have chosen. Once finished, upload your completed file to the EHBs.

Excel File: Upload your completed file to the EHBs.
HTML File: Export an Excel file from the HTML file then upload the completed Excel file to the EHBs.

5. Click

Download Template DOWh|Oad after
Select Format @ Offline O offline & Download mal kl ng d | I
Excel @ HTML @ 10N
1. Select to sccetons

download Excel Template
Offline Excel

Select Data Level ® Excel with O Blank

Data Excel
2 . Se | eCt Wlth Select Table (v mTable 5 [ Table 8D
Table 6A Table 9E
Data Table Patients by ZIPgg
Code
FdTable 3A @3 Table 6B ETable HIT
Table 3B Table 7
Other Data Elements
FaTable 4 [aTable 8A 3 Workforce i
3. Select All or 4. Option to
Ind|V|dua| tables () Patients by ZIP Code with Prior year ZIP Codes InC|Ude prIOF
(This option will append the zip codes reported last year to any data already entered for this year. If you have .
to d OW n | o a d already entered zip code information for this year, be certain to check that none of the zip codes have been Zl p CO d ES

entered twice, since this option does not include a duplicated entry check )
 SERVIC Go To Status Overview Page Continue to Upload Page
ECU g
& P

W LHRSA
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Table Patients by ZIP Code

e When downloading the Excel template with data, you
can choose to include ZIP codes from the previous
year on the table

e This feature is only available when downloading the
Table Patients by ZIP Code (PBZC)

e Provides for easy data entry for this table and saves
time in searching for zip codes

Health Center Program
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Offline Excel File

Unique file

. © ) n a e a n d . ey _
ave (@ off) [ UD520225ubmission-09E00352Version1 7 . 2arc t+
Notes about .

data entry Home Insert Page Layout Formulas Data Review View Help AcroN
type - £

A B C D
Note - Data for this table are

1 |expected to be numbers.

2 Line Age Groups Male Patients (a) Female Patients (b)
3 1 Under age 1 1

4 2 Age 1

5 |3 Age 2

6 4 Age 3

7 |5 Age 4

B E 0.0 0000000606050 0.0 0060000000 00000 0000000000000 00 0 0.0
o3 (31 Ages 50-54

34 |32 Ages 55-59

L~ e | Amae RN_AA

3 | Readme | T-PBZC | T-PBZC-Cther T3A-Univ T3A-HCH | T3A-MHC T3A-PHPC T3B-Univ T3B-HCH T3B-MHC T3B-PHPC Td-Univ ... [«]

Select table

to work on

AHRSA
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Excel Mapping Tool

e Provides easy mapping to
forms/rows/columns/cell address in
downloadable Excel file

e To support health centers with automating data
Document population in downloaded Excel file

e Use the cell address mapping to automate the
data population in Excel template

Excel Mapping

Health Center Program
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Excel Mapping Tool — Data Transfer Flow

o ®
‘e
o
o ® ' O
Health Center ® Excel Mapping UDS Excel ubs
o Data Document Template Report in
O ® O EHBs
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@0
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Offline Excel Upload Overview

e Be sure to upload the file! The EHBs will verify the file format,

tabs, and structures before accepting the file

e The EHBs will assign a unique filename on upload. This will
: have the Bureau of Primary Health Care’s Health Center
Excel File Management Information System ldentification Number

Upload

(BHCMISID) and Version Number

e On successful upload, the UDS forms will be populated with
the data from the file

e |f you upload a blank Excel template it will clear all data that
was previously entered

e Upon upload, you will see a listing of the tables that were
uploaded as part of the success message

AHRSA

Health Center Program




Offline Excel Upload o Ve

Download a Custom at(lre /
Template :
The Download Custom
Template option allows
you to choose the UDS
tables individually, in

groups or all tables.

(i)

All Functions « Download a Blank
Template
The Download Blank
Performance Reports ~ -{" Template option
downloads ALL UDS
UDS Upload/Download SRlREL e Tabies with no data
Upload included.
Download File Excel File
Download a
. Template with Data
‘ Upload File g
‘ The Download Template
with Data option includes
Clear Data ALL UDS tables with
information already

entered into the tables.

‘ Upload a File
’ Once you have
completed your data

s SERICE [~ ..
' ) entry in excel, click here

_/( to upload your file. @HR&

rving Health Center Program
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Offline Excel Upload File

Click to
select file

to upload
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Upload File

» Resources (£

Instructions

Upload your UDS data in the Offline Excel Template. You can upload an Excel Template that contains all UDS tables or a subset of tables. Once your file has been successfully processed, you

can view any errors for the last uploaded data by accessing the error file in the Error Summary section below.
Reminder: Any uploaded data (including blank data) will replace data that is already in the EHBs.

Upload File

™ | Choose File |No file chosen

A Warning:

System may take some time to process the data.

Error Summary

Number of Edits Verified Number of Edits Failed Download

Continue to Upload Page

Go To Status Overview Page

&

-

AHRSA
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Offline Excel Upload Results

v Success: Success message

listing updated
Your file has been uploaded successfully for Tables(s) Patients by ZIP Code, 3A, 3B, 4, 5, BA tables

Upload File

| Choose File IL,IDS test spreadsheet2 xls | X Process File |

A Waming: Click Process Unique file and
. File to upload version name.
System may take some time to process the data. file into EHBs

Click to view
file
Error Summary

Number of Edits Verified Number of Edits Failed Download

5800 0 UDS2022ErmorFiled33620Version2

File

@ information @HRSA

Health Center Program




Uploaded File Summary

Uploaded
File

e Be sure to upload the file! The EHBs will verify the file format, tabs,
and structures before accepting the file

* On successful upload, the UDS forms will be populated with the
data from the file

* The EHBs will assign a unique filename on upload. This will have
the Bureau of Primary Health Care’s Health Center Management
Information System ldentification Number (BHCMISID) and Version
Number

* If you upload a blank Excel template it will clear all data that was
previously entered

* Upon upload, you will see a listing of the tables that were uploaded
as part of the success message

AHRSA

Health Center Program




Upload History

Upload
History

e |[n Resources section, select Upload History

e All previously uploaded files will be listed as newest to oldest,

only for current reporting year

e Download these files by clicking on filenames displayed as

hyperlinks

AHRSA

Health Center Program




Offline Excel Tips

e There is no restriction on the number of times a file can be
uploaded or downloaded.

HElprl e An Uploaded file and associated Error file will always have the
o same version number
TIpS ’ e Version number is increased by 1 with each successful upload

(e.g.v1, v2, etc.)

AHRSA

Health Center Program




Demo #3

UDS Offline Excel Demo
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Quiz Question #2

True or False: When downloading the Offline Excel
File, you must download all tables.

A. True
B. False

ERVIC: . -
g S
S o
5
1 / :
5
) @
oy
T,

Health Center Program

£
h"ﬂ’u




Quiz Question #2 Answer

True or False: When downloading the Offline Excel
File, you must download all tables.

Answer: (B) False
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Offline HTML

aHRSA

Health Center Program
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Offline HTML Overview

Offline HTML Overview

7

Download HTML package to facilitate offline data entry

Download can be for entire report or select tables

[ Mirror image of UDS forms in EHBs including the validation |
checks for edits

 Use Import feature for data entry or manually enter data on
the forms

After completing data entry, Export the data into Offline

’ |
> Don't Forget: Excel file and Upload into EHBs

—[ Downloaded offline forms open in Chrome browser only ]

Health Center Program
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Offline HTML Download

All Functions &«

Performance Reports ~

UDS Upload/Download

Select to
download :
. Download File
offline Excel or
offline HTML Upload File
Clear Data

Health Center Program
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Offline HTML Download (continued)

Download File

» H80CS0000

» Resources (&'

Instructions
click the Dowload button to complete your request
With either file you can download specific tables or all the tables required for the UDS report. Please note that each time you download a file, it will be populated with any data that is in the EHBs.
Enter or change data in the file you have chosen. Once finished, upload your completed file to the EHBs.

Excel File: Upload your completed file to the EHBs.
HTML File: Export an Excel file from the HTML file then upload the completed Excel file to the EHBs.

Click Download

Download Template .
after making

To enter UDS data offline, select either the Excel file (spreadsheet format) or the Offline HTIML file (forms-based format). Then select whether you want a blank form or to include any existing data. Once you have made all of your selections,

Important Note:
Before clicking
Download, have

your tracking
number available to
open the file.

Select Format O Offline Excel @ ® Offline HTML Se|eCtI0nS
[i]
Select to
open Offline
Select Table @Al [Table 5 FaTable 9D
HTML Table 6A Table 9E
Table Patients by ZIP Code
ETable 3A MTable 6B fTable HIT
ETable 3B [aTable 7 EOther Data Elements
M Table 4 faTable 8A F3'Workforce Select Al I or
(3t SERVICE - . .
& ) Go To Status Overview Page lndIVIduaI tables
to download

Continue to Upload Page

Health Center Program
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Offline HTML Download (continued 2)

e Select Extract All and then enter the tracking number as the
password to extract and open the files

e The downloaded package will have multiple files, click on
UDSSubmission HTMIL files to access the offline forms

Offline Package
Download

)
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Offline HTML View

All Functions «
You are now using the Offline HTML tool that can be used to enter and validate UDS data in preparation for reporting. No internet connection is required to use this file. Your data will need to be exported to an Excel

Performance Reports ~ File, then uploaded to the EHBs to run the Data Audit Report and complete reporting.
UDS Import Export

Import File I Table Patients by ZIP Code o

Reminder you
Export File
15 Renort Dot © Note: are working in
eport Detalls You are currently working in HRSA offline HTML tool Version 1.0.0. It was downloaded 10/07/2022 3:45 PM EST. You do not need to be connected to the Internet to enter data in to your UDS forms t h Offl .
X Table Patients by ZIP € In€e
Code 8
» H80CS000C HTML view,
! Table 3A
not UDS
% Table 3B ¥ Resources (' .
, Environment

X Table 4 UDS Manual ;

% Table 5

Status: X Not Started

% Table 6A

% Table 6B + Add Multiple ZIP Codes & Download Patients by ZIP Code

% Table 7 Moo« [ 1of1 s | M Pagesize 15 0 items in 1 page(s)

% Table 8A

X Table 9D ZlFE s

% Table S9E

% HIT Capabilities ZIP Code None/Uninsured Medicaid/CHIP/Other Public Medicare Private Total Patients Action

(@) (b) (e) (d) (e) (f)
% Other Data Elements
X Workforce + Add Row
Tl SERVICE, ,

%

AHRSA
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Offline HTML Data Entry

Offline HTML forms will have the same
look and feel as the UDS forms in the
EHBs

Users will be able to navigate to
different forms using the left navigation
menu

{ Data Entry ]

Data entered will result in data edits
appearing on the forms, similar to
EHBs forms

Important! For the data to be in the
EHBs, you must export the HTML forms
to Excel and then upload the Excel file

to the EHBs

AHRSA
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Offline HTML Import File

All Functions

Performance Reports ~

UDS Import Export

Import File

Export File

Click to import
data from an excel

file to the Offline
HTML form

You are now using the Offline HTML tool that can be used to enter and validate UDS data in preparation for reporting. No internet connection is required to use this file. Your
data will need to be exported to an Excel File, then uploaded to the EHBs to run the Data Audit Report and complete reporting.

Ib Import File
© Note:

You are currently working in HRSA offline HTML tool Version 1.0.0. It was downloaded 10/05/2021 4:46 PM EST. You do not need to be connected to the Internet to enter data in to your
UDS forms.

» H80CS0D

v Resources (£

UDS Manual |

Instructions

Import the populated perfor[pance e e te be iccessful import of the excel file, data will be reflected on the offline forms. You can navigate to the forms from the left menu to

view the imported data.
Select to choose file

Import File

Choose File | No file chosen

Select to Import

file to Offline

HTML view

AHRSA

Health Center Program




Offline HTML Export File

All Functions

You are now using the Offline HTML tool that can be used to enter and validate UDS data in preparation for reporting. No internet connection is required to use this file. Your
data will need to be exported to an Excel File, then uploaded to the EHBs to run the Data Audit Report and complete reporting.

Performance Reports
I Export File

Note:
UDS Import Export o
You are currently working in HRSA offline HTML tool Version 1.0.0. It was downloaded 10/05/2021 4:46 PM EST. You do not need to be connected to the Internet to enter data in to your
UDS forms.
Import File
» HBOCSO

Export File

» Resources (£

Instructions

Click to export data

from Offline HTML
to Offline Excel

Export the performance report data into a template file. SeleCt to export
HTML form to

Offline Excel

Export Template File

Select Format ® Excel & Export File

Required step if you want the data transferred to the EHBs! Once exported to Excel, you can upload the file into UDS. @HRSA
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Offline HTML Tips

e There is no restriction on the number of times a package can be
downloaded

e Downloaded offline forms open in Chrome browser only

Helpful e There is no restriction on the number of times Excel files can be
imported or exported

e Exported Excel files will match the offline package structure, such as
entire report or a select few tables.

Tips!

Health Center Program
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Demo #4

UDS Offline HTML Demo
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Clear Data, Data Audit Report, Review and
Submit Report
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Clear Data Overview

e Easily clear all information entered for the
entire report or select tables

Clea I e You can clear data entered directly in EHBs or
Data uploaded using the Excel template
e Before clearing data, a warning message is
Featu re provided for users to confirm they are aware all

data for selected tables will be deleted
permanently
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Clear Data

All Functions

Performance Reports ~

UDS Upload/Download ¥ Clear Data

Download File » H80C 0000

Upload File » Resources (&

Instructions

Clear Data

Caution: Tables selected will be cleared of any existing data in the EHBs (uploaded or entered online). Deleted data will be permananently lost. Please note that selecting a table would cause data to be cleared for all associated funding
streams.

Click Clear Data
after making

Select to
delete data on Select Table Oa O Table 5 O Table 2D

(J Table Patients by ZIP Gode [ Table 8A (J Table 9E selection
tables

0 .
Select tables to O Table A O Table 68 HIT Capabilties

[ Table 3B U Table 7 (J Other Data Elements
clear O Table 4 O Table 8A O workforce Clear Data
Go To Status Overview Page Continue To Next Page

AHRSA
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Data Audit Report (DAR) Details

e Run the DAR after completing table(s) to verify
data consistency

DAR e Before submitting the report, you must
complete all forms, run the DAR, and fix or
explain each edit
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Data Audit Report Process

All Functions «

I Data Audit Report

The Data Audit Report (DAR) must be run when changes are made and saved on a Table. Do this by clicking the ‘Run Data Audit Report button below. The ...

A Warning:

Report can take between 2 to 4 minutes to generate, please be patient.

Performance Reports ~
UDS Upload/Download
Download File
Upload File

Clear Data » H80CS00

UDS Report Details

, » Resources [
Status Overview

X Contact Information

v Patients by ZIP Code Date of Last Report Refreshed: 09/22/2022 11:50 AM EST  [GILISE e RN IRESE
« Table 3A . . .
Table Edit Type Flag Status Edit Status Action
VY Y YYVYY.
~s All v | Al v Al v All v
X Report Comments No records found.
¥ Data Audit Report ]
P Date of Last Report Refreshed: 09/22/2022 11:50 AM EST

Review

Previous Page Continue To Next Page

Health Center Program
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Data Audit Report Process (continued)

Error

description

& SERVIC,.
G ey

%,

o HEALY,
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I Data Audit Report
The Data Audit Report (DAR) must be run when changes are made and saved on a Table. Do this by clicking the ‘Run Data Audit Report’ button below. The ...

A Warning:

Report can take between 2 to 4 minutes to generate, please be patient.
» HBOCSO0C

» Resources ('

Status: ! In Progress

Date of Last Report Refreshed: 09/22/2022 11:50 AM EST

Table Edit Type Flag Status Edit Status Action
All VAl VoAl v All v
v Patients by ZIP Code Explainable Error Not Flagged Edit 3390: Patients by Zip Code in Question Pending Fix Patients by ZIP Code ~
Action
Description:All center patients are being reported under one zip code. Please Fix Patients by ZIP
correct or explain. Code
Add/Edit Explanation
Table 3A Explainable Error Not Flagged Edit 3855: Total Patients in Question Pending Fix Table 3A

Description:The number of total patients (26754 ) reported on Table 3A is the
same as last year. Verify that the numbers have not changed and correct or
explain.

Date of Last Report Refreshed: 09/22/2022 11:50 AM EST
Go to Previous Page Continue To Next Page

Actions to fix
or explain
error

AHRSA
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Review Report

All Functions « .
Review

Performance Reports ~

P HB0CS000
UDS Upload/Download

Download File

» Resources [
Upload File

Clear Data Print All Forms

UDS Report Details

Status Overview Review
% Contact Information Table Action
¥ Table Patients by ZIP
Code Contact Information View (&'
!' Table 3A .
i View (' . .
Ll lldlldll s Table Patients by ZIP Code Click View to
Data Audit R Table 3A - Patients by Age and by Sex Assigned at Birth View (4 open _tables and
Review Table 3B - Demographic Characteristics View (£
Submit Click Review to
select tables Table 4 - Selected Patients Characteristics View ('

to open

AHRSA
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Submit Report

All Functions «

Performance Reports ~

UDS Upload/Download ; .
Submit and Print

Download File

Upload File
O Make sure you have completed and validated

all the required information before submitting this
UDS Report Details
report.
Status Overview

% Contact Information

Clear Data

¥ Submit Performance Report

Click Submit
Performance Report
Click Submit Code when finished with

with the

¥ .
X Table Patients by ZIP & Compare Versions

&= Print Report

O VWY VY VYNYNVYNYVYYY.

report

® Data Audit Report

Review

oot AHRSA
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Submit Report (continued)

b Submit

» H80CS00 H

» Resources (4

Fields with ¥ are required

% UDS CERTIFICATION

| certify to the best of my knowledge and belief that this UDS Report is true and correct.

Type "l Agree" in the text box to the electronically sign the UDS Report

Complete
Certification

Cancel

AHRSA
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View Submitted Report

& Submissions - All

Not Completed Recently Completed All

E:‘ Export To Excel [=] Detailed View | 4= Search | [..H Saved Searches w

LI |I L Pagesize: 15 +* Go 4 items in 1 page(s)

Submission Name Submission Type Organization Grant # Tracking # R;’::i::‘g Deadline Submitted Date Status Options
' All v All v (W W W H v B |7 All W
Performance 01/01/2021 - .
123/ Perfi Report:
» UDS Performance Report Siriiz . HB80CS00 H80CS3 19/31/2021 03/23/2022 03/22/2022 Submitted erformance Reports

Click to view

submitted
Performance
Report
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Submitted Report Data

£ HRSA

You are NOW using the UDS Reporting Environment. Please prepare, vali and submit year UDS data at this time.
Iy Review and Report List Page

» HB0CS000

Reports

Report Name Description Action

UDS Data File in XML Submitted Raw UDS Data File in XML format Download

UDS Data File - Excel Format Download a copy of your health centers' submitted UDS Performance Report in an excel format including data in all tables and forms. Download

UDS Health Center, State, National Summary The Summary Report is a ‘dashboard' report intended to describe each health center in a statistical manner. Calculations of key measures are derived from their View

Report own organization's current reporting on the UDS. The measures are broken out into two main categories: 1) Demographic and Clinical Data (Patients, Visits, CI o k t
Staffing and Clinical Information) and 2) Fiscal Information (Costs and Revenues) and provide an overall picture of the health center's performance in each of IC 0
these areas.

L L L L L P L L LLLLLLLELLLLLLLILLLLLLILLLLLLILILLLLLLL L LLELELLLLLLEL L L NN LS IPL Downloador

Formula Guide. UD's Health Cener Trena Report VieW d ata

UDS Health Center Performance Comparison The Health Center Performance Comparison Report for individual health centers provides calculations of key measures at different levels, i.e., Health Center, View b . d

Report State, National, Urban, Rural, National Percentiles (25th, 50th, and 75th. The report categories are Quality of Care/Health Outcomes, Costs per Patient, and S U I I . Itte 0 n
Costs per Visit

CI . k t P . t Formula Guide: UDS Health Center Performance Comparison Report p
Forms Print All Forms

Review

Table Action

Contact Information view ('

Table Patients by ZIP Code view &'

Table 3A - Patients by Age and by Sex Assigned at Birth View Cl | C k to Vl eW

S LRS- P PP PP PPPPPPPPIPIPIPIPIIIIIPIPIPIPIPIINIPIOIIse Su bm|t
Data Audit Report view ('
All Comments View &'

AHRSA
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Submitted Report Confirmation

‘You are NOW using the UDS Reporting Environment. Please prepare, validate, and submit complete calendar year UDS performance data at this time.

b Submit Confirmation

¥ H80CS0000
Submission Status: Accepted

Funding Stream(s): CHC

BHCMIS ID:
Started By: on 12/22/2021 03:59 PM ET

Reporting Period: 01/01/2021 - 12/31/2021
Performance Report

+ Success:
Submission Tracking Number

UDS Report was successfully submitted and received by HRSA

. Please keep record of the tracking number for future reference.

The tracking number for your submission is H80C S0001
Your report will now be sent for review. During this process you may be contacted by the reviewer for additional questions related to your submission. All such guestions will be directed to the contact person that you have specified in your report.

All UDS reporting questions should be directed to the UDS support line - 866-UDS-HELP (866-837-4357) or Email at udshelp330@bphcdata.net

All technical/system issues should be directed to BPHC help line - 1-877-974-BPHC or Email at bphchelpline@hrsa.gov

AHRSA
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Demo #5

UDS Other Features, DAR, Review, and Submit Demo
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Quiz Question #3

What does the Clear Data feature do?

A. Permanently deletes all data for selected tables
B. Deletes entire tables from the report
C. Changes the font to white

s —
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Quiz Question #3 Answer

What does the Clear Data feature do?

Answer: (A) Permanently deletes all data for selected
tables
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Resources

Wiki Help
Pages

Quick
Reference
Guides

HRSA
Help Desk
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Questions and Answers
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Thank You!

UDS Help Desk EHBs Customer Support
@ udshelp330@bphcdata.net @ Fill out our contact form
% 866-837-4357 % 877-464-4772

Health Center Program Support

@ http://www.hrsa.gov/about/contact/bphc.aspx

2 877-464-4772

bphc.hrsa.gov

’A N Sign up for the Primary Health Care Digest
£ cHRSA

Health Center Program
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mailto:udshelp330@bphcdata.net
https://www.hrsa.gov/about/contact/ehbhelp.aspx
http://www.hrsa.gov/about/contact/bphc.aspx
https://bphc.hrsa.gov/
https://public.govdelivery.com/accounts/USHHSHRSA/subscriber/new?qsp=HRSA-subscribe
https://public.govdelivery.com/accounts/USHHSHRSA/subscriber/new?qsp=HRSA-subscribe
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Connect with HRSA

Learn more about our agency at:

WWW.HRSA.gov

’A"‘ Sign up for the HRSA eNews

FOLLOW US:

flviolinla

AHRSA
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http://www.hrsa.gov/
https://public.govdelivery.com/accounts/USHHSHRSA/subscriber/new?qsp=HRSA-subscribe
https://public.govdelivery.com/accounts/USHHSHRSA/subscriber/new?qsp=HRSA-subscribe
https://facebook.com/HRSAgov/
https://twitter.com/hrsagov
https://www.instagram.com/hrsagov/
https://www.linkedin.com/company/us-government-department-of-health-&-human-services-hrsa/
https://www.youtube.com/user/HRSAtube
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